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_________________________________________________________________________________________ 

This description contains notices which you should observe to ensure your own personal 
safety, as well as to protect the product and connected equipment. These notices are high-
lighted in the manual triangle and are shown as follows according to the level of danger: 

Safety  
Notes 

  
  
Danger  
indicates that death, severe personal injury or substantial property damage will result if proper 
precautions are not taken. 

 

  
  
Warning  
indicates that death, severe personal injury or substantial property damage can result if proper 
precautions are not taken. 

 

  
  
  
Caution  
indicates that minor personal injury or property damage can result if proper precautions are not 
taken. 

 

  
  
  
Note  
draws your attention to particularly important information on the product, handling the prod-
uct, or to a particular part of the documentation. 

 

  
  
Only qualified personnel should be allowed to install and work on this equipment  Qualified 
persons are defined as persons who are authorized to commission, to ground, and to tag cir-
cuits, equipment, and systems in accordance with established safety practices and standards. 

Qualified  
Personnel 

  
  
Note the following: Correct  

Usage 
  
  
Warning  
  

 This device and its components may only be used for the applications described in the catalog 
or the technical description, and only in connection with devices or components from other 
manufacturers which have been approved or recommended by Siemens. 
 
This product can only function correctly and safely if it is transported, stored, set up, and 
installed correctly, and operated and maintained as recommended. 
  
  
  

Trademarks TELEPERM®, SIMATIC® and SINEC® are registered trademarks of SIEMENS AG. 
Third parties using for their own purposes any other names in this document which refer to 
trademarks might infringe upon the rights of the trademark owners. 

 
Copyright © Siemens AG 2002-2008  All rights reserved Disclaimer of Liability 
 
The reproduction, transmission or use of this document or its 
contents is not permitted without express written authority. 
Offenders will be liable for damages. All rights, including rights 
created by patent grant or registration of a utility model or 
design, are reserved. 

 
We have checked the contents of this manual for agreement 
with the hardware and software described. Since deviations 
cannot be precluded entirely, we cannot guarantee full agree-
ment. However, the data in this manual are reviewed regularly 
and any necessary corrections included in subsequent edi-
tions. Suggestions for improvement are welcomed. 

Siemens AG 
Automation and Drives 
Industrial Automation Systems 
76181 Karlsruhe, Germany 

 
© Siemens AG 2002-2008 
Subject to technical change. 
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_________________________________________________________________________________________ 

1 Introduction 
 
Using the PCS 7/TM-OS interface to SIMATIC BATCH requires knowledge of SIMATIC BATCH 
/1/ and the basic functions /2/, /3/. 
 
This documentation describes the following: 
• All the necessary steps in configuration in the SIMATIC MANAGER and in the 
• TM Manager 
• The AS function blocks EM1B, UNIB, and the optional TR1B  
 
The system software required on the OS is listed in the actual product information of PCS 7/TM-OS. 
 
The system software required on the AS is listed in /2/. 
 
 

2 General Information 
 
2.1 Block Structure on the AS  
 
 

UNIB TR1B 

5 

 
 
The schematic shows the basic structure of the blocks required on the AS for use with SIMATIC 
BATCH. 
 
 
 

EM1B EM1B ......... TR1B 

  GF   GF 

optional 

optional 
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2.2 Interfacing BATCH – PCS 7/TM-OS – TELEPERM M-AS  
 
 

BATCH Server 
UNIT 
TAG_COLL 
  EQPARAM_REAL(10x) 
  EQPARAM_BOOL(10x) 
EPH/EOP 
  EQPARAM_ENUM 
  EQPARAM_RAL(6x) 

IUNIT_BLOCK 
TAG_COLL 
  IEPAR_REAL(10x) 
  IEPAR_BOOL(10x) 
IEPH/IEOP + SKS 
  IEPAR_ENUM 
  IEPAR_REAL(6x) 

UNIB blocks 
TR1B blocks 
EM1B- + SKS 
blocks 

EQM file 

WinCC tag  
management and 
messages 

AS blocks 

 
 
 
 
 
 
 
 
 
 
 
 
 PCS 7/TM-OS  
 
 
 
 
 
 
 
 
 
 
 TELEPERM M-AS  
 
 
 
 
 
 
 
 
 
The schematic shows the data exchange between SIMATIC BATCH, WinCC tag management and AS 
function blocks. 
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_________________________________________________________________________________________ 

Block instances of SIMATIC BATCH blocks are created in the WinCC tag management for the 
TM_BATCH interface blocks EM1B, TR1B, and UNIB as shown below:  
 
Function Block on the AS Block Instance in WinCC Notes 
   
EM1B 1 x IEPH or IEOP  

1 x SKS 
1 x IEPAR_ENUM 
6 x IEPAR_REAL 

The decision IEPH or IEOP is 
made via the IEOP (3 PB) input of 
the EM1B block. 

   
TR1B 1 x TAG_COLL 

10 x IEPAR_BOOL 
10 x IEPAR_REAL 

 

   
UNIB IUNIT_BLOCK  
   
 
The block instance names are assigned according to a fixed convention (see Section 4) as can be seen 
in the following example: 
 
Function Block Name on the 
AS 

Block Instance Name in WinCC Notes 

   
EM1B, 0210 IEPH or IEOP , 0210 

SKS , 0210 
IEPAR_ENUM , 0211 
IEPAR_REAL , 0212 ... 0217 

 

   
TR1B, 0220 TAG_COLL , 0220 

IEPAR_REAL , 022B ... 022K 
IEPAR_BOOL , 0221 ... 022A 

 

   
UNIB, 0200 IUNIT_BLOCK , 0200  
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_________________________________________________________________________________________ 

3 Steps in Configuration  
 
3.1 Requirements 
 
The configuration of the WinCC tag management is based on the corresponding PROGRAF AS+ files 
(export files, library files BEL.DAT, ...) /4/. 
If the parameters FTYP, ENR1, LOR2...LORD, UPR2...UPRD and ANSW of the EM1B blocks 
should be used, a corresponding configuration of the AS is necessary. 
For more notes concerning the configuration see chapter 4 of this document. 
 
 Note: 

For configuration the RAM image has to be done in resting state, i.e. no recipe is active. 
Afterwards in PROGRAF all limit values must be set to the correct values. 

 

 
3.2 General Procedure 
 
To create the entire WinCC tag management (structure definitions, block instances) and to configure 
the SIMATIC BATCH messages in WinCC Alarm Logging for use in SIMATIC BATCH, a tempo-
rary SIMATIC AS project is created for TELEPERM M applications using the SIMATIC Manager 
configuration tool. This temporary SIMATIC AS project is used among other things to create the re-
quired SIMATIC BATCH block structures used by the TM Manager to create block instances.  
On completion of block import by the TM Manager, the temporary SIMATIC AS block instances are 
removed again as the last activity in configuration step 3 (Section 3.4). 
 
The following configuration steps are documented in the main with screenshots. Pictures illus-
trating obvious or self-explanatory situations were omitted. Obvious instructions such clicking 
on the "Next" button have also been left out.  
Within the further development of the software involved, there may possibly be differences be-
tween the dialogs etc. appearing on your screen and those shown in this description. So it may be 
necessary to consult other documentations like the online help of SIMATIC BATCH and adapt 
them. 
 
 Note: 

For information on configuring the AS function blocks, see Section 4.  
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_________________________________________________________________________________________ 

 
3.3 Configuration Step 1: SIMATIC Manager 
 

• Start the SIMATIC Manager and select File > Retrieve ... master library TmsbmusterCPU.zip 
or TmsbmusterPRO.zip from the <...>\Siemens\TM_Werkzeuge\Batch folder and unpack it to 
the <..>\Siemens\Step7\S7LIBS folder. 
 
There are two alternative ways of creating the SIMATIC project that affect the configuration 
of messages: Unique message numbers either only within a CPU or within a project. Select ei-
ther TmsbmusterCPU.zip (within a CPU) or TmsbmusterPRO.zip (within the project). 
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_________________________________________________________________________________________ 

 
After the file has been unpacked, the sample project is opened: 

 

 
 

• Create a new PCS 7 project with File > 'New Project' Wizard... with the options WinCC ap-
plication and BATCH application: 
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As the project type, select "Single Project" for example: 
 

 
 
 
 

For the CPU, please select the CPU 417-4: 
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_________________________________________________________________________________________ 

 
Under "OS Objects", select the options "PCS 7 OS" and "SIMATIC BATCH" as well 
as “Multi-user system”: 
 

 
 
You can specify any folder name and any storage location. In the sample, the default 
has been changed and the folder is called BATCH_01 and the path is 
D:\PCS7_Projekte. 
 

 
 
Here, you also specify unique message number assignment for the CPU or unique 
message number assignment for the project. Select the option to meet your require-
ments. 
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_________________________________________________________________________________________ 

Concerning the message configuration a SIMATIC project can be created in two different alternatives: 
CPU-oriented (default setting) or project-oriented message numbers. 
 

 
 
 
 
 

After clicking "OK", the basic structure of the project is created: 
 

 
 
Note: 
You can modify the names of the individual objects (for example, OS(1) under WinCC Application) 
using SIMATIC Manager tools (here already done). 
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_________________________________________________________________________________________ 

 
The OS name must be identical with the symbolic computer name, the default name has to be changed: 
 

 
 
 

• Keep both projects open in the SIMATIC Manager (the unpacked sample TMMuster project 
and the project you have created). 
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_________________________________________________________________________________________ 

• Via Shared Declarations > Enumerations > Insert New Object > insert enumeration and re-
name is “Fahrweise” (in German!): 
 

 
 
 

• Mark “Fahrweise” and click Object Properties. Activate there “Control strategy”: 
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_________________________________________________________________________________________ 

• Via Fahrweise > Insert New Object > Value insert value and rename it FW1: 
 

 
 
 

 
 
Via “Properties” FW1 enter value 1. Configure the same way for FW2 … FW6 (value = 2 … 6). 
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_________________________________________________________________________________________ 

• In analogous manner configure the data type MES_EventType, define via “Properties” 
MES_EventType1 and give it the value = 1. 
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_________________________________________________________________________________________ 

 
• Open Plant View: 

 

 
 
Note: 
Here, you should rename the default names Process cell(1) and Unit(1) to suit your particular project. 
The name of the unit may have up to 16 characters only. 
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_________________________________________________________________________________________ 

 
• Mark Process cell(1) or modified name and right-click > Insert New Object > Hierarchy folder: 
 

 
 
A new folder named "Unit(2)" will be created. It is the sample folder for TELEPERM M. 
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_________________________________________________________________________________________ 

 
• Mark in the sample project the 4 objects Funktion(1), CFC(011), TA_Muster and TMMusterCPU 

(or TMMusterPRO), copy and insert them into the new project under "Unit(2): 
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_________________________________________________________________________________________ 

• Mark Process cell(1) (or modified name) and right-click > Insert New Object > Hierarchy 
folder: 

 

 
 
A new folder named "Unit(3)" is created. It is a real process cell. This step is necessary in order to 
define the batch types. The name "Unit(3)" may be modified, it does not have any effect on the ongo-
ing configuration. The name of the unit may have up to 16 characters only. 
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_________________________________________________________________________________________ 

 
• Mark Unit(3) (or modified name) and right-click > Insert New Object > Hierarchy folder: 
 

 
 
Function (1) is created. Modify name of the created function if you wish. 
 
 
• Copy CFC(F11) under Unit(2)/ Function(1) and insert it into Unit(3)/ Function(1) and rename it: 
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_________________________________________________________________________________________ 

• Open CFC (in example above CFC(F31)) 
 

 
 
The opened CFC contains a sample phase of maximal structure, i.e. 6 control strategies with each 6 
setpoints which are specific concerning control strategy and which are independent concerning control 
strategy. Furthermore it contains 1 PI and 1 PO inclusive string. PI is the first parameter of control 
strategy 1, PO is the first parameter of control strategy 6. The other parameters are REAL values. 
These values must me adapted to the concrete batch type, and the batch type (f.e. "Stir1") has to be 
configured in the IEPH block. 
 
The other units are configured in the same way. 
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_________________________________________________________________________________________ 

 
• Copy the object TM_Muster in Unit(2) and paste it in Unit(1) and Unit(3) as well as in all those 

units you have configured and rename them. Afterwards rename the unit names of the renamed 
TA_Muster in CFC. 
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_________________________________________________________________________________________ 

 
• Select the Chart > Compile >  Charts as Program menu command and close CFC: 
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_________________________________________________________________________________________ 

 
• Mark Unit(1) and Unit(2) and right-click > Object properties > S88 Type Definition. Set the 

object type <Standard> and click the OK button: 
 

 
 
 
• Mark Multiproject name with right mouse click > SIMATIC BATCH, mark Batch types and 

click button "Generate". 
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_________________________________________________________________________________________ 

• Start generating batch types of all selected projects:  

 
 
 
• For all phase types mark the parameter “01_FW”: 
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_________________________________________________________________________________________ 

• With phase types, you can decide for each control strategy which parameters (SP1 ... 6) will be 
displayed during recipe creation so that they can have values assigned to them. Point to "01_FW", 
select "Properties" and then click the "Edit" button: 

 

 
 
 

• Complete the type definition with the "Generate" button and then close the dialog with OK. 
 

• Start propagating batch types of all selected projects: 
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_________________________________________________________________________________________ 

• In the plant view select Unit > Object Properties > S88 Type Definition and assign the ob-
ject type "Unit"; this is to do for all existing units: 

 

 
 

 
• Via menu Options > ‚Compile Multiple OSs’ Wizard is started. For that at first the areas are 

assigned to the OSs:  
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_________________________________________________________________________________________ 

 
• In the next step the Operator Stations and the associated areas are selected: 

 
 
 
 

• In the next dialog box the options "Entire OS" and "With memory reset" (select "Picture Tree" 
only at first run or if you wish to construct the picture hierarchy completely new) are selected, 
and after it the compilation is started: 
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_________________________________________________________________________________________ 

• Mark Multiproject, navigate in menu SIMATIC BATCH > Multiproject > Settings and update 
„Distribution“ and „OS Objects”: 
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_________________________________________________________________________________________ 

• Mark Multiproject and use SIMATIC BATCH > Batch instances > Merge to merge and compile 
BATCH instances: Set the option “Compile”, select the associated projects and press the button 
“Start”: 

 
 
 
• Dialog box after compilation: 
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_________________________________________________________________________________________ 

• Via menu SIMATIC BATCH > Process cell  > Transfer messages the Batch-relevant messages 
are transferred to OS: 
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_________________________________________________________________________________________ 

• Via SIMATIC BATCH > Process cell > Download download Batch Process cell: 
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_________________________________________________________________________________________ 

Configuration Status: 
After this step, all the SIMATIC BATCH block structures and messages have been created in 
the WinCC tag management. One (temporary) SIMATIC S7 PROTOCOL SUITE with block 
instances also exists under the connection type MPI. 
 

 Note: 
If the Batch types are modified again later, the steps must be repeated starting from "Op-
tions > SIMATIC BATCH > Batch types  > Generate". 

 

 
 
 
 
 
3.4 Configuration Step 2: TM Manager 
 
See description of PCS 7/TM, Chapter 3 
• Open the WinCC application and insert a TELEPERM M channel. 
• Keep the SIMATIC Manager and the project open. 
• Create block structures – without TM_BATCH interface blocks - in the WinCC tag management 

using ORPA Import. 
 
 Note: 

With reference to Section 2.2,  no structure definitions are created for the function blocks 
EM1B, TR1B, and UNIB. 

 

 
• Create connections and block instances in the WinCC tag management using Block Import. At the 

same time, the assignment of the technological function blocks to the UNIB block instances must 
be configured by left-clicking on the "Batch" column for the relevant block instances: 

 
 Notes: 
 Under a connection (AS) up to 128 EM1B instances only may be defined. 

The AS internal block number of EM1B may not exceed 190.  
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_________________________________________________________________________________________ 

 
 
 
 The block instances of the EM1B blocks already have an assignment to the UNIB blocks. 

An incorrect entry can be removed by selecting the entry and exiting the open box with "Can-
cel". 
 

 Note: 
 If the BATCH block EM1B or TR1B has been created incompletely into the WinCC tag 

management (at least one parameter variable missing, or has already been defined), this 
block is nevertheless marked as "created in the WinCC tag management" in the block 
filter list. In order to characterise this incompleteness of a EM1B/ TR1B block, the type 
name is shown as "EM1B??" or "TR1B??" respectively in the filter an delete dialog. In-
ternally a EM1B or TR1B block is still existing.  
 
 
If the check mark of an incomplete EM1B is reset the existing parameter variables are 
deleted during block import. 

If the check mark of an incomplete EM1B is set the missing parameter variables are de-
fined. 

 
 
 Please note: 

This assignment must be configured as otherwise the configuration of Alarm Logging will 
be incomplete. 

 

 
 Note: 

The .EventState variables of the SKS blocks created implicitly during SIMATIC BATCH 
configuration must not be used to link tags to WinCC pictures etc. 
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_________________________________________________________________________________________ 

• Create messages in WinCC Alarm Logging using the import message function. 
 
Configuration Status: 

After this step, all the TELEPERM M connections, the entire tag management with all structure 
definitions and block instances, and the messages have been created. SIMATIC S7 
PROTOCOL SUITE and its block instances still exist. 
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_________________________________________________________________________________________ 

 
3.5 Configuration Step 3: WinCC, SIMATIC Manager 
 
• Create Measured Value Archives in WinCC Tag Logging if desired 
• Close the WinCC project 
• Compile the OS once more; deselect the S7 program/Process cell, entire OS with memory reset.  

Ignore warnings about undeleted structures: 
 

 

 
 
 

Configuration Status: 
After this step, all the TELEPERM M connections, the entire tag management with all structure 
definitions and block instances, and the messages have been created. The measured value archive 
has also been created. The SIMATIC S7 PROTOCOL block instances are removed again. 
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_________________________________________________________________________________________ 

 
3.6 Configuration Step 4: TM Manager/ BATCH Import 
 
• Open the WinCC application, start BATCH Import and using the "..." button, find the EQM file. 

This is located in the project folder \BatchPrj\<generated folder name>\. If the Batch instances are 
distributed over several WinCC applications Batch import has to be done for all OS stations one 
after another in order to read all Batch instances and types. 
Note: In multiprojects the EQM file has to be selected from the Batch folder of the multiproject 

and not from the Batch folder of the individual projects. 
 
• Assign the name of the process cell of the BATCH application as the process cell name (in this 

example, this is "Process cell(1)".) 
The "Ignore previously built data" check box specifies whether or not an EQM file from an earlier 
configuration session should be taken into account. If the Batch instances are stored in several 
WinCC applications the "ignore" button is only valid for the present WinCC station. The parame-
ters of the other WinCC stations are furthermore assumed into the EQM file. 
 
The "Delete previous EQM-File" button deletes the EQM file contained in the part of the configu-
ration specific to TELEPERM M. Only the part configured in the SIMATIC Manager will then be 
mapped to SIMATIC BATCH. 

• With the selection „Package or OS name“ the package is determined if there are defined several 
OS servers in the project. If the button is clicked then a selection list is offered; it contains the ex-
isting packages and the OS name. Then the selected name is used as prefix in the runtime names of 
the BATCH blocks. 
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_________________________________________________________________________________________ 

• After reading the file by clicking on the appropriately labelled button, the instances are then 
re-edited: 

 

 
 
 

For the several Control Strategies and MES_EventType it must be assigned a value:  

 
 

Modifications may be done here if necessary. 
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_________________________________________________________________________________________ 

 
 Note: 

Any configuration of limits will not be transferred into the AS. They have to be configured 
in the EM1B blocks themselves. 

 

 
Functions of the buttons: 

Update: 
Synchronizes instances and types. This step is necessary only if you change the as-
signment of instances to different classes or types, or if you modify classes and types 
when instances already exist. The function is not used in TELEPERM M. 

New/ Delete: 
Create new instances or delete instances. The 'New' function has no practical purpose 
in conjunction with TELEPERM M and is therefore deactivated. 

Check validity: 
A structural analysis of the instances is run. Results will be entered in a log file.  

Display Log: 
Problems detected in the validation are entered in the log file. You can open and dis-
play this log. 

 
• Check validity 
• If the validation is error-free, you can exit with the OK button. 
• Click the Write EQM-file button and close BATCH Import with the "Cancel / Exit" button 
 
 

By clicking the Write EQM-file button, the result of the configuration is entered in the 
PCC_BATCH.eqm file. If there are still validation errors at this time, the result is saved in the 
temporary file PCC_BATCH.EQM_TMP, so that it is available for further work when the tool is 
opened again. The program then closes. 
 

 Note concerning reconfigurations: 
 Method 1:  

After having added parameters to a batch type the affected batch instances are corrected 
manually: Runtime-name "not mapped" has to be overwritten with the related WinCC 
variable name (f.e.: OS(1): AS3_IEPAR_REAL_0236). In case of only few batch in-
stances to be modified, and if the configurator knows the name convention of WinCC 
variables this method is the easiest way. 
In all other cases it may be done like modifying block types.  
Method 2:  
Step a) BlockImport: Delete the block instances which use the modified batch type.  
Step b) BatchImport: Create new EQM file with the deleted batch types. 
Step c) BlockImport: Re-insert the block instances which use the modified batch types. 
Step d) BatchImport: Create new EQM file with the added batch types. 
After step d) the resulting EQM file contains the batch instances of the modified batch 
type. 
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3.7 Configuration Step 5: SIMATIC Manager 
 
• Mark Multiproject and use SIMATIC BATCH > Batch instances  > Process cell > Download 

download Batch Process cell: 

 
 

Configuration Status: 
After this step, the created EQM file has been transferred to the BATCH server. 
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3.8 Configuration Step 6: BATCH Control Center 
 
• Right click on Update process cell: 
 

 
 
 
Configuration Status: 
After this step, the units of the TELEPERM M AS are added to the BATCH Service Center. 
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4 Guidelines for Configuring AS Function Blocks 
 
During the installation of PCS 7/TM, a compressed PROGRAF AS library with the name 
BatchSSB.zip is transferred to the <...>\Siemens\TM_Werkzeuge\Batch folder and can be used to 
configure interface blocks. 
 
How to Use BatchSSB.zip 
 
1. Transferring Batch interface block types 
 
The interface blocks are supplied in the BATCHSSB.zip file. After unpacking the file, start 
PROGRAF AS+ and select the automation system.  
 
a) whether 
Libraries/Import->Transfer  
Select Libraries: BatchSSB.235  
Element types: Select Importbatch 
Library elements:select MUST_BV6 
and then ->Transfer. 
EXIT. 
 
The AFB types EM1B, OP1B, TR1B and UNIB as well as the corresponding PROBLEMS EM1B and 
EM1E are imported. The instance OP1B.EM1B is created. 
 
The other PROBLEMs may be used on demand as substitute für L999 (LGR9) or GAB, as well as the 
PROBLEM.EM1C for manual mode of the GF block. 
 
b) or 
 
Libraries/Import->Transfer  
Select Libraries: BatchSSB.235 
Element types: Select AFB TYP, then as displayed in Library elements: 

OP1B 
EM1B 
TR1B 
UNIB 

one after the other and then ->Transfer. 
 
Element types: Select PROBLEM, then as displayed in Library elements: 

EM1B 
EM1E 
EM1C 
LGR9 
GAB 

one after the other and then ->Transfer. 
EXIT. 
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2. Transferring Model Blocks 
 
In the CSF Editor: Create a chart (e.g. model chart) 
Library ->Transfer  
Libraries: select BATCHSSB.235 
Library elements:  select MUSTERBV6 
Transfer. 
Check the log and ignore lines with "...Visibility identifier identical..". 
NEXT 
Place interface blocks in the chart. 
The UNIB, EM1B, SKS and TR1B interface blocks are now available for configuration. 
 
Naming Convention (see picture) 
 
The import of the data necessary for SIMATIC BATCH is done by the BatchImport module that is 
started from the taskbar. You only need to specify the path of the .eqm file. 
The function blocks for SIMATIC BATCH receive a name with 4 characters (x1x2x3x4) as their in-
stance names. 
 

Phase level /
operation /
unit-specific process tag

Unit level /
global process tag

TR1B 0200 UNIB F300UNIB K100

EM1B K120EM1B K110 TR1B K130 EM1B F310 EM1B F320

Numbered consecutively

Numbered consecutively Numbered consecutively

45 

Unique for interface blocks of a unit

 2 Numbered
consecutively

Unit level: Should be numbered consecutively; range of values from 1 through 8
and then continuing with A through Z.

Phase level: Should be numbered consecutively within a unit; range of values 1
through 9 and then continuing with A through Z

0 or 00 Must always be 0.

Legend:

UNIB K100
Instance name (K= x1, 1 = X2, 0 = x3, 0 = x4)
Type name

 
 
x1:is free for the customer *) 
x2:[1-9], [A-Z]  identifies the unit or global process tag *) 
 UNIB (IUNIT_BLOCK) (unit), TR1B (TAG_COLL)(process tag) 
x3:[0-9], [A-Z] identifies the phase or the unit-specific process tag. 0 is possible only at the higher 

level 
 TR1B (TAG_COLL), EM1B (IEPH or IEOP). 
x4: [0]  mandatory, required for the lower-level parameter blocks (IEPAR_BOOL, IEPAR_REAL and  

IEPAR_ENUM). 
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*) The x2 character must be assigned uniquely to a unit or process tag on the AS. The x1 character can 
be different per unit or process tag on the AS, however all components of this unit or process tag use 
the same x1 character. 
 
Block instances with the same instance names must not occur. Example: UNIB,0200 and TR1B,0200 
or UNIB,0200 and TR1B,A200 are not permitted. 
 
The SKS blocks assigned to the EM1B blocks have identical block names. The SKS blocks serve as 
extension of the status bits to the EM1B blocks. 
 
 Note: 

This naming convention must be adhered to!  
 

AS609

TR1B 0220

UNIB 0200

EM1B 0210
 .
INT_EAD_24

WinCC tag management

      GF

Heat

SP1

SIMATIC BATCH

     AKS_600

TR1B 0100
      AS block

Phase in Batch / instance in WinCC

IEPH 0210

IEPAR_REAL 0212
  .SPVAL

:
IEPAR_REAL 0217

IEPAR_ENUM 0211

SKS 0210

TR1B 0230
(Archive)

Logical relationship

Data flow

Channel

Conv. list WinCC blocks   
:

IEPAR_REAL0212.SPVAL
:

 AS blocks
:

EM1B0210.INT_EAD_24
:

 
 
This figure shows how the channel works based on the example of a write job for the first setpoint of 
the "Heat" function. At the same time, the naming convention is illustrated in a practical situation. 
 
Processing Cycles 
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The values of the EM1B block relevant for SIMATIC BATCH are read in a 1 second cycle. It is there-
fore necessary for the EM1B blocks to be processed in a 1 second cycle. The lower-level GF blocks 
can be configured in higher processing cycles. Since an EM1B block is processed more often than its 
lower-level GF block, it is unavoidable that commands to this GF block are active until it has adopted 
the new status (ZUCD) and has signalled this to the EM1B block. 
 
Interconnection with other Blocks 
 
The inputs of the EM1B blocks must not be interconnected with other function blocks. 
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5 EM1B Block 
 
5.1 Function 
 
The EM1B user function block represents the interface between SIMATIC BATCH V6.00, on one 
hand, and the GF block (version ≤ V1.3 see description in /2/) in the AS 235 or AS 488/ TM on the 
other. Each EM1B block requires an SKS block. The SKS block must not be installed in a cycle! 
The OP1B block serves as interface to SIMATIC BATCH. An instance named EM1B of this block 
must exist. 
 
 
5.2 Configuration 
 
Before installation in the processing sequence, the following inputs of the EM1B block and SKS block 
must have parameter values assigned and be interconnected to the assigned GF block and SKS block: 
 
The inputs 1, 2, 4, 6, 8, 10, 12, 16 and 18 of the SKS block must have the value 0 assigned. This step 
can be omitted if these blocks were created as copies from the model chart within PROGRAF AS+. 
 
Input 44 EA of the EM1B block must be interconnected with the GF block (header interconnection): 
 A,EM1B,aaaa; 
 Q,44,GF,bbbb,0; bbbb = block name of the corresponding GF block. 
  
Input 45 EA of the EM1B block must be interconnected with the SKS block (header interconnection): 
 A,EM1B,aaaa; 
 Q,45,SKS,aaaa,0; 
 
Input 1 EB (BAEN) must have the value 1 assigned to operate with SIMATIC BATCH. 
 
At input 3 you select the mapping as IEPH (set 0) or IEOP (set 1). 
 
The parameters 4, 5, 8, 9, 11, 23 ,26 to 62 must be assigned the value 0 after definition of a block in-
stance. This step can be omitted if these blocks were created as copies from the model chart within 
PROGRAF AS+. 
 
You can use inputs 68 through 71 for your own use to interconnect a GA, GB, GM or GT block. 
 
All necessary parameter links with the GF block are made internally in the program in EM1B and do 
not require additional interconnection. 
 
The SPR1 parameter (input 23) contains the control strategy.  
 
With the SIMU parameter (input 43), you can switch over between normal mode (=0) and simulation 
mode (=1). In simulation mode, no signals are forwarded to the GF. 
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5.3 Modes 

5.3.1 Normal Mode (SIMU = 0) 
 
The EM1B block reads the status of the GF block (ZUCD) cyclically and converts it according to the 
SIMATIC BATCH standard as follows: 
 
  

State Status of GF block, parameter 
ZUCD (4 ID) 

EM1B block (SIMATIC 
BATCH), internal parame-

ter STA2 (51 ID ) 
   

Off 0 1 
>Run 1  

Run +.RDY = 0B 2 2 
Run + .RDY = 1B 2 32 

>Hold 3  
Held 4 8 
>End 5  
End 6 4 when completed or 16 

when aborted or 64 when 
stopped 

 
Note: The intermediate states >Run, >Hold and >End are signalled in the internal STA3 variable. The 
.RDY parameter of EM1B must be set or deleted to signal the READY state. 
 
  

State Status of GF block, parameter 
ZUCD (4 ID) 

EM1B block (SIMATIC 
BATCH), internal parame-

ter STA3 (52 ID ) 
   

Off 0  
>Run 1 2 if started or 4 if resuming
Run 2  

>Hold 3 16 
Halt 4  
>End 5 8  when completed or 32 

when aborted or 64 when 
stopped 

End 6  
 
 
 
The block state is entered in the status word QSTA (output 1 ) and is formed from the internal vari-
ables listed above STA2, STA3 and STA4. 
The automatic identifier corresponds to the BAEN (BATCH enable) status. 
SIMATIC BATCH reads the value of the block status  cyclically. 
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Depending on the status, EM1B reads the following inputs that can be set by SIMATIC BATCH and 
forwards them to the GF block and resets them: 
 

Status (to GF standard) Input: Reaction 
0 (OFF) OCCU = 1 GF.BLAU = 1 

 OCCU = 0 GF.BLAU = 0 
 BAEN = 1 GF.AUEX = 1 
 BAEN = 0 GF.AUEX = 0 
   
 RST = 0 
 PARA Set control strategy, set 

setpoints, 
= 0 

   
 ABRT = 0 
 If STRT= 1 GF.AUEX = 1 
 -then control strategy SPR1 GF.FWEX = SPR1 
  Start command to GF: 

STEX = 1 
 -then ABEX  = 0 
   

1 (>RUN)  Process values of last run 
are reset 

 ABRT GF.ABEX= ABRT 
GF.STOP= ABRT 

 STOP GF.STOP = STOP 
   

2 (RUN) + RDY = 0B HOLD GF.HTEX = HOLD 
 ABRT GF.ABEX= ABRT 

GF.STOP= ABRT 
 STOP GF.STOP = STOP 
  GF.STEX = 0 
  GFF.FOEX = 0 
 PARA Set control strategy, set 

setpoints, 
= 0 

2 (RUN) + RDY = 1B HOLD GF.HTEX = HOLD 
 ABRT GF.ABEX= ABRT 

GF.STOP= ABRT 
 STOP GF.STOP = STOP 
  GF.STEX = 0 
  GFF, FOEX = 0 
 CONT Call PROB.EM1B 
 CONT + STRT Call PROB.EM1B 
 TERM Call PROB.EM1B 
 PARA Set control strategy, set 

setpoints, 
= 0 

   
3 (>HOLD) STOP GF.STOP = STOP 

 ABRT GF.ABEX= ABRT 
GF.STOP= ABRT 
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Status (to GF standard) Input: Reaction 
   

4 (HOLD) HOLD = 0 
 STRT GF.FOEX = STRT 
 ABRT GF.ABEX= ABRT 

GF.STOP= ABRT 
 STOP GF.STOP = STOP 
  GF.STEX = 0 
  GF.HTEX = 0 
   

5 (>END) STOP GF.STOP = STOP 
 ABRT GF.ABEX= ABRT 

GF.STOP= ABRT 
   

6 (END) If GF.ABEX = 0 STA2 = 4 (COMPLETED)
 If GF.ABEX = 1 STA2 = 16 (ABORTED) 
 If STOP = 1 and GF.ABEX = 0 STA2 = 64 (STOPPED) 
  GF.ABEX = 0 

 ABRT  = 0 
 HOLD  = 0 
 If RST = 1 GF.ABEX = 1 

 
Explanation of the Abbreviations 
 
1. EM1B Block 
 

STRT 12 PB Start 
HOLD 13 PB Hold 
STOP 14 PB Stop 
ABRT 15 PB Abort 
RST 16 PB Reset 
TERM 17 PB Terminate 
RDY 18 PB Ready 
CONT 19 PB Resume 
PARA 20 PB Set control strategy, set setpoints, 
   
STA2 66 ID Internal status (basic status) 
STA3 67 ID Internal status (intermediate) 

 
2. GF Block 
 

AUEX 32 EB Automatic external 
HTEX 33 EB Hold external 
STEX 35 EB Start external 
FOEX 34 EB Resume external 
ABEX 36 EB Abort external 
FWEX 38 EA Control strategy external 
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5.3.2 User Interface 
 
Two user programs PROB.EM1B and PROB.EM1E belong to the EM1B block. Both programs can be 
extended by the user when necessary. The PROB.EM1B program is used to check the commands and 
setpoints and may need to be adapted by the user. It is called when a command is applied. 
 
Below, there is an excerpt from the parameter transfer for PROB.EM1B: 
 
/** ANSCHLUSS ZU EM1B,PRUEFEN DER KOMMANDOS**/; 
/**   V1. 06  02.09.03  A&D AS RD53        **/; 
/* LA0 = ADRESSE EM1B-BAUSTEIN */; 
/* LA1 = ADRESSE GF  -BAUSTEIN */; 
/* LA2 = AUFTRAG VON EM1B-BST. */; 
/* LB0 = 0B OK, 1B = FEHLER    */; 
/* BESCHREIBUNG AUFTRAG LA2              */; 
/* 1: BEFEHL .PARA: FAHRWEISE,SOLLWERTE  */; 
/*    BEI LOCK = 1B                      */; 
/* 2: STARTEN     .STRT                  */; 
/* 3: FORTSETZEN  .STRT -> .FOEX         */; 
/* 4: ANHALTEN    .HOLD                  */; 
/* 5: BELEGEN     .OCCU = 1B             */; 
/* 6: FREIGEBEN   .OCCU = 0B             */; 
/* 7: FAHRWEISE EINSTELLEN .SPR1         */; 
/*    SOLLWERTE,GRENZEN IN GF UEBERTRAGEN*/; 
/*    EINHEITEN,GRENZWERTE IN EM1B BEI BAEN = 0B */;  
/* 8:                                    */;  
/* 9: BEFEHL      .STOP = 1B             */; 
/* 10:BEFEHL      .ABRT = 1B             */; 
/* 11:RUECKSETZEN .RST -> GF...ABEX = 1B */; 
/* 12:BEFEHL .TERM= 1B -> GF..??.(RDY =1B) */; 
/* 13:BEFEHL .STRT= 1B -> GF..??.(RDY =1B) */; 
/* 14:BEFEHL .CONT:                      */; 
/* 15:BEFEHL .ITAK: FAHRWEISE,SOLLWERTE  */; 
/*    IN RUNTIME                         */; 
/* 16:STEX FOEX LOESCHEN                 */; 
/* 17:FAHRWEISE LOESCHEN                 */; 
/*    SOLLWERTE LOESCHEN                 */; 
 
The PROB.EM1E program is used for cyclic processing to form the status word and can, for example, 
write the Ready status to input 18 RDY. 
 
 
Below, there is an excerpt from the parameter transfer for PROB.EM1E: 
 
A,PROBLEM,EM1E; 
/** ANSCHLUSS ZU EM1B,ANWENDER-ERWEITERUNG **/; 
/**   V1. 05  03.07.03  A&D AS RD53        **/; 
/* LA0 = ADRESSE EM1B-BAUSTEIN */; 
/* LA1 = ADRESSE GF  -BAUSTEIN */; 
/* LB0 = 0B OK, 1B = FEHLER    */; 
DE;;
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State Transition Diagram for GF including Interface Blocks 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

53 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Legend: 
 
 
Intermediate status: 
 
 
 
Status: 
 
 
Command: 
 

HOLD/ 
HOLD 

STOP/  
ABORT 

RESUME/ 
 RESUME 

Step end/  
Self-completing 

END 
-------------------------- 

COMPLETE 

>END 
-------------------------- 

COMPLETING 

>END 
-------------------------- 

ABORTING 

END 
-------------------------- 

ABORTED 

STOP/ 
STOP  

RESET 

START/ 
START 

GF/ 
SB 

OFF 

GF 
-------------------------- 

SB 

GF 
-------------------------- 

SB 

END 
-------------------------- 

STOPPED 

>END 
-------------------------- 

STOPPING 

----------------------------- 
IDLE 

>RUN 
-------------------------- 

STARTING 

RUN 
-------------------------- 

RUNNING 

>HELD 
-------------------------- 

HOLDING 

>RUN 
-------------------------- 

RESUMING 

HELD 
-------------------------- 

HELD 

*
*

ZUCD=5 /  
TERMINATE 

HOLD/ 
HOLD 

START/ 
 START + ICONT 

RUN + IREADY 
-------------------------- 

READY TO COMPLETE 

RESET 

* :  Can be reached from all 
states and intermediate 
states (except END and 
OFF). 

 

The intermediate statuses relate to the GF (GF block) but are not indicated in the SB (interface block). 
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5.3.3 Simulation Mode (SIMU = 1) or Control Strategy 90 / 91  
 
In the simulation mode, no GF block is addressed. 
The time for RUNNING is set in seconds using the STP parameter (input 11). 
The SPR1 parameter (control strategy) specifies whether or not the phase changes to the 
"COMPLETE" status (SPR1=90) or the "READY" status (SPR1=91) after the simulation. During the 
"RUNNING" status, the parameters SPR3 through SPR7, are increased by 0.157, as long as # 0, and 
applied to the outputs QAR3 to QAR7. 
The SPR2 parameter specifies how long the program waits in an intermediate state in seconds. 

5.3.4 Manual Mode  
 
When the GF block operates in manual mode, setpoints and control strategy can be changed directly. 
In order to inform EM1B about these changes the user programm PROB.EM1C may be used. 
To use the subroutine PROBLEM.EM1C a small addition has to be inserted in the program 
GF.CHECK: 
 
1. The program EM1C may be called either from the GF.CHECK routine or in the online part (on 
demand, not cyclically). 
 
2. Condition of the GF block is that the block name is the same as the one of the EM1B block.. 
(The EM1B block will be searched). In order to check if a EM1B block with the same name exists, the 
last lines of PROBLEM.EM1C may be activated. In an error case a process control system message 
with error number S 324 will be generated. 
 
/* ELSE  */; 
/*    LA0 UND 0 =: LA2 */; 
/*    CALL SYSTEM.SFE */; 
/*    GIVE -32444,LA2,LA0 */; 
/* KEIN EM1B-BAUSTEIN MIT DEM GLEICHEN NAMEN VORHANDEN */; 
 
3. In GF.CHECK or in the attached PROBLEM the following call has to be inserted at the end of the 
corresponding STEP (STEP 150, 157, 162, 167, 172, 177 and 182) for each operating alternative of 
FW, W1 till W6  
  
 CALL PROBLEM.EM1C; 
 GIVE LAx,order; 
 
LAx = data record, order = concerning the below mentioned order number. 
 
4. The current GF data record and an order number is transferred as parameter to the program: 
 
order = 0 : (on change of setpoint, STEP 157, 162, 167, 172, 177 and 182 in GF.CHECK ) the  set-
points (W1 till W6) and the control strategy (FW) are pasted in the variables of the  EM1B block 
and the flag RFSH in EM1B block will be set. 

 
 order = 1 : (on change of control strategy, STEP 150 in GF.CHECK ) the upper and lower limits , the 
 units, the setpoints (W1 till W6) and the control strategy(FW) are pasted in the variables of 
 the EM1B block and the flag RFSH in EM1B block will be set.. 
 
The EM1B block transfers RFSH via the status word to SIMATIC BATCH and deletes RFSH. 
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Following an excerpt of the parameter transfer to PROB.EM1C: 
 
A,PROBLEM,EM1C; 
TAKE LA0,LA1; 
/**   V1.  0  09.10.03  A&D AS RD53          **/; 
/* WERTE BEI HANDBEDIENUNG VON GF IN EM1B KOPIEREN */; 
/* LA0 = DATENSATZ VON GF-BAUSTEIN            */; 
/* LA1 = 0: FAHRWEISE,SOLLWERTE               */; 
/* LA1 = 1: FAHRWEISE,SOLLWERTE,GRENZEN,TEXTE */; 
/* ZUR KONTROLLE OB EM1B-BAUSTEIN VORHANDEN IST, */; 
/* KANN ELSE-ZWEIG AM PROGRAMMENDE AKTIVIERT WERDEN */; 
 
 
5.4 Fault Causes if EM1B Block sets ERROR in QSTA Output 

   
The indication of QSTA is negative (Bit 31 =1), in SIMATIC BATCH a flash symbol is shown,  
Additionally a error number is written to the output .RAA4 (only relevant if in column ERROR "*") 

   
Cause   

   
Command is refused ERR

OR 
RAA4 Extension 

   
   After a command from SIMATIC BATCH the PROBLEM.EM1B 

is called, the error number is the same as the STEP number; 
the error case may be defined by the user (e.g. wrong control 
strategy) 

   command 
  * 1 PARA, check control strategy, setpoints 
  * 2 STRT 
  * 3 resume 
  * 4 HOLD, hold 
  * 5 OCCU = 1, occupy 
  * 6 OCCU = 0, free 
  * 7 control strategy 
  * 9 STOP 
  * 10 ABRT, abort 
  * 11 RST, reset 
  * 12 TERM, terminate 
  * 13 STRT at RDY = 1 (flying change of control strategy) 
  * 14 CONT = 1 
  * 105 (15) Take control strategy/ setpoints at RUNNING  
  * 16 Delete STEX / FOEX  
  * 17 Delete setpoints 

Condition error GF and EM1B block 

   
   GF block has an improper state: 
   
  * 100 OCCU = 1 but GF .ACE = 0  
  - 101 GF after occupying not in OFF or >RUNNING  
  - 102 GF changes from  >RUNNING to OFF, >HALT, HALT 
  * 103 GF on Abort out of LAUF not in AUS,>ENDE or ENDE 
  * 104 GF on  Stop out of LAUF not in AUS,>ENDE or ENDE 
   105 - 
  - 106 GF changes from LAUF to >LAUF or AUS 
  - 107 GF changes after Terminate from LAUF + RDY to 

>LAUF,LAUF, >HALT or HALT 
  - 108 GF changes from >HALT nach AUS, >LAUF,LAUF 
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  - 109 GF changes from >ENDE a out of LAUF to 
>LAUF,LAUF,>HALT,HALT (Abort) 

  - 110 GF changes from >ENDE out of LAUF to 
>LAUF,LAUF,>HALT,HALT (Stop) 

  - 111 GF changes from ENDE to 
>LAUF,LAUF,>HALT,HALT,>ENDE 

  - 112 GF changes from HALT to >HALT  
  - 113 GF changes on Fortsetzen from HALT to AUS,>HALT or 

HALT 
  - 114 GF changes on Abbrechen from HALT to 

>LAUF,LAUF,>HALT or HALT 
  - 115 GF changes on Stoppen from HALT to >LAUF,LAUF,>HALT 

or HALT 
  - 116 GF changes from ENDE to 

>LAUF,LAUF,>HALT,HALT,>ENDE 
  - 117 GF changes from LAUF + RDY to AUS, HALT 
  - 118 GF changes from Anhalten in LAUF + RDY to AUS, >LAUF, 

LAUF 
  - 121 EM1B in READY + RESUMING 
  - 122 EM1B in STOPPED and GF not in AUS or ENDE 
  - 123 EM1B in IDLE , internal state 
  - 124 EM1B in RUNNING , internal state 
  - 125 EM1B in HELD , internal state 
  * 126 GF in >ENDE without STOP or ABRT 
  * 127 GF in ENDE without STOP or ABRT 
  * 128 GF in HALT, EM1B in HOLD mit ERROR 
  * 129 GF changes from >RUNNING to >ENDE 
  * 130 GF in >HALT with ERROR (.SAST) 
   

Feedback 
PROBLEM.EM1E 

* 120 Free of use for the user  

   
Feedback GF block 
variable SAST 

* 119 GF block sets the variable .SAST 
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5.5 Number of EM1B Block Instances under a Connection  
 
The number of EM1B block instances under a connection (AS) may not exceed 128.  
The AS-internal block number may not exceed 190.  
 
Addional configuration notes: 
 

• If EM1B blocks are existing in an AS, the CS 275 bus load is optimized by means of the OP1B 
block (OP1B.name = EM1B.name). 
Per AS 4 parameters are read each second. The CS 275 bus load produced by that amounts 
about 0.4% per AS. If more than 17 EM1B blocks have been altered since the last read-in, all 
EM1B blocks have to be read. 

 
• In the latter case 4 parameters will be read per EM1B block. The CS 275 bus load produced 

by that amounts about 0.3% per block. 
 

• At system start also a complete read-in of all EM1B blocks will be made. 
 
In worst case an additional CS 275 bus load will be engendered by reading all EM1B blocks which 
should not be neglected. 
For estimating this CS 275 bus load following formular may be used: 
additional CS 275 bus load = sum of all EM1B blocks within the system * 0.3% 
 
Example: 5 AS with 60 EM1B blocks each and 1 AS with 180 EM1B blocks 

 Additional CS 275 bus load = 480 * 0.3 % = 144%. 
With a cyclically CS 275 bus load of 60% for example, the additionally 144% would be dis-
persed on (144% / 40%) s = 3.6 s. During this time the CS 275 bus will be used to capacity 
(100%). After 3.6 s the CS 275 bus load will return to 60%. 

 
Please check whether this short-time 100% peak load of the CS 275 bus can be tolerated from system 
view. 
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6 TR1B Block 
 
6.1 Function 
 
The TR1B block has no logic. It is used to make 10 binary and 10 analog parameters available for the 
transition conditions to be formulated in SIMATIC BATCH. 
 
6.2 Configuration 
 
Parameters 3 to 23 must be interconnected after a block instance is defined. The data is supplied by the 
blocks created to allow the transition conditions to be formulated in SIMATIC BATCH. 
 
 

7 UNIB Block 
 
7.1 Function 
 
Batch control coordinates the allocation of individual units to the batches using the UNIB block. A 
UNIB block must exist for every unit (in other words, an instance in one of the charts of the hierarchy 
folder). 
 
7.2 Configuration 
 
Input 1 EB (BAEN) must have the value 1 assigned to operate with SIMATIC BATCH. This step can 
be omitted if they were created as copies from the model chart within PROGRAF AS+. 
 
The parameters  2, 3, 4, 16, 17, 19, 21, 22 and 23 must be assigned the value 0 after definition of a 
block instance. This step can be omitted if they were created as copies from the model chart within 
PROGRAF AS+. 
 
7.3 How the Block Works 
 
Allocate/Release 
 
To allocate a unit, batch control sets OCCUPIED(OCCU) identifier to 1. It also enters the following 
allocation information: 
 
Batch name, batch ID (UBA_NAME(BAN1), UBA_ID(BAID)) 
 
Recipe name, recipe version, formula category (URP_NAME(RPN1), URP_REL(RPR1), 
FORMULA(FOR1)) are listed in the WinCC database and in the channel. 
 
The material name and material code (MAT_NAME(MAT1), MAT_SP(MASP)) of the product to be 
produced in the batch are listed in the WinCC database and in the channel. 
 
The block is occupied only when it is released for SIMATIC BATCH (BA_EN(BAEN) = 1) and there 
is no group error (status word bit 31 = 0). 
When it is released again, the OCCUPIED(OCCU) is simply set to 0. The allocation information is 
retained until it is deleted by SIMATIC BATCH and can be used in the user program and in the plan-
ning of further batches. For example, if the same product is planned, no cleaning batch is necessary 
between production batches. 
 
Status word: 
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The state of the UNIB block is available in the status word Q_STATUS(QSTA) and is monitored by 
SIMATIC BATCH. 
 
User status word: 
 
The USER_STATUS(USTA) parameter is a status word that can be set by other PC applications and 
is available on the OS as QUSER_STATUS(QUST). It can then be queried on the OS by the relevant 
applications. The status word must not be used by a user program. 
 
Block status word: 
 
The UNIB block contains a TELEPERM M status word. This generates state messages according to 
the PCS 7 implementation of IUNIT_BLOCK. 
 
Sign-of-life monitoring: 
 
At intervals that can be set in SIMATIC BATCH, batch control sends a "lifebeat" to all occupied 
UNIB blocks to signal to the block that the AS-OS connection still exists and that batch control is 
working. 
 
If the "Lifebeat" is not received within the interval set in SIMATIC BATCH, the UNIB sets 
AS_OS_ERR(OERR) to 0. This allows the user program to react to the missing connection to Batch 
Control. If the connection is reactivated ("Lifebeat" received again), the AS_OS_ERR(OERR) output 
is set to 1 again. 
 
SP_COUNT(SPCT) = 0: deactivated / VA_COUNT(VACT) constant 1 
 
SP_COUNT(SPCT) > 0: VA_COUNT(VACT) is decremented at 1 second intervals starting 
from SPCT.  
If VA_COUNT(VACT) = 0, the monitoring time has elapsed, in other words, no contact to the OS or 
batch control. 
If LIFE(LIFE) = TRUE, the monitoring with SP_COUNT(SPCT) is restarted. 
 
AS_OS_ERR(OERR) constant 1, if connection is OK or SP_COUNT(SPCT) = 0 
AS_OS_ERR(OERR) constant 0, if SP_COUNT(SPCT) <> 0 and VA_COUNT(VACT) = 0 
 
Deactivating a Unit 
 
The UNIB allows specific units to be deactivated (locked) preventing them from being used by batch 
control. The PEND_OOS(POOS) (pending out of service) input sets an internal trigger. If the unit is 
not occupied, BA_EN(BAEN) is set to 0 immediately. If the unit is allocated to a batch 
(OCCUPIED(OCCU) = 1), the UNIB waits until batch control cancels the allocation and then sets 
BA_EN(BAEN) to 0. 
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8 Special Points to Note 
 
8.1 Tips 
 
• If you want to view the recipe data in the interface blocks of the AS, it is advisable to formulated 

the recipe data such as recipe name, batch name, material code, and material name only in upper-
case letters. 

 
• The BATCH launch coordinator must only be started after initiating WinCC runtime. 
 
• When creating recipes, avoid configurations in which the same recipe phases of the same unit 

(UNIB) run at the same time. 
 
 

9 Appendix 
 
9.1 Operator Control and Monitoring 
 
SIMATIC BATCH provides a tool with which you can configure user objects with the OCX technol-
ogy for TELEPERM M-specific interface blocks. 
 
 
9.2 ORPA Filter 
 
The ORPA filter for the EM1B, OP1B, SKS, TR1B, and UNIB function blocks is as follows: 
 
EM1B: 
I = 1 - 255 
S = STATUS 
 
OP1B: 
I = 1 - 13 
 
SKS: 
E = 27 
S = STATUS 
 
TR1B: 
I = 1 - 255 
 
UNIB: 
I = 1 - 255 
S = STATUS 
 
 Note: 

If the SKS standard function block is also used with applications external to SIMATIC 
BATCH, you can, of course, add any extra parameters you require. 
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9.3 EM1B Block Data Record 
 
 
   1 AAD QSTA  0.0000           #          Status word        12  
   2 AAD STPT  0.0000           #          Step execution time   13 
   3 AAD QSR1  0.0000           #          Copy of contr strat   26 
   4 AAD QAR1  0.0000           #          Proc val cont strat  27 
   5 AAD QSR2  0.0000           #          Copy of setpoint 1  31 
   6 AAD QAR2  0.0000           #          Process value 1       32 
   7 AAD QSR3  0.0000           #          Copy of setpoint 2  36 
   8 AAD QAR3  0.0000           #          Process value 2      37 
   9 AAD QSR4  0.0000           #          Copy of setpoint 3  41 
  10 AAD QAR4  0.0000           #          Process value 3       42 
  11 AAD QSR5  0.0000           #          Copy of setpoint 4  46 
  12 AAD QAR5  0.0000           #          Process value 4      47 
  13 AAD QSR6  0.0000           #          Copy of setpoint 5  51 
  14 AAD QAR6  0.0000           #          Process value 5      52 
  15 AAD QSR7  0.0000           #          Copy of setpoint 6  56 
  16 AAD QAR7  0.0000           #          Process value 6      57 
  17 AAD QSR8  0.0000           #                                61 
  18 AAD QAR8  0.0000           #                                62 
  19 AAD QSR9  0.0000           #                                66 
  20 AAD QAR9  0.0000           #                                67 
  21 AAD QSRA  0.0000           #                                71 
  22 AAD QARA  0.0000           #                                72 
  23 AAD QSRB  0.0000           #                                76 
  24 AAD QARB  0.0000           #                                77 
  25 AAD QSRC  0.0000           #                                81 
  26 AAD QARC  0.0000           #                                82 
  27 AAD QSRD  0.0000           #                                86 
  28 AAD QARD  0.0000           #                                87 
  29 AB  QSRE  0                #                                91 
  30 AB  QARE  0                #                                92 
  31 AB  QTAK  0                #                                95 
  32 AB  RAB0  0                #                               132 
  33 AB  RAB1  0                #                               133 
  34 AB  RAB2  0                #                               134 
  35 AB  RAB3  0                #                               135 
  36 AB  RAB4  0                #                               136 
  37 AAD RAA0  0.0000           #                               137 
  38 AAD RAA1  0.0000           #                               138 
  39 AAD RAA2  0.0000           #                               139 
  40 AAD RAA3  0.0000           #                               140 
  41 AAD RAA4  0.0000           #                               141 
   1 EB  BAEN  0                #  P       Batch enable        1 
   2 S16 FTYP  F_TYPE                 16   Type name           2 
   3 PB  IEOP  0                           Identifier         3 
   4 EAD STNO  0.0000           #  P       Step number       4 
   5 EAD BAID  0.0000           #  P       Batch ID          5 
   6 S16 NAM1  UBA_NAME               16   Batch name        6 
   7 S16 NAM2                         16                       7 
   8 EAD CTRL  0.0000           #  P       Control word          8 
   9 EB  OCCU  0                #  P       Allocated ID       9 
  10 ID  LOP       0                       No. step activations  10 
  11 EAD STP   0.0000           #  P       Setpoint step exec  11 
  12 PB  STRT  0                           Start command      14 
  13 PB  HOLD  0                           Hold command       15 
  14 PB  STOP  0                           Stop command       16 
  15 PB  ABRT  0                           Abort command      17 
  16 PB  RST   0                           Reset command     18 
  17 PB  TERM  0                           Terminate command    19 
  18 PB  RDY   0                           Sets status word  20 
  19 PB  CONT  0                           Sets status word  21 
  20 PB  PARA  0                           New parameter rec   22 
  21 PB  LOCK  0                           Sets status word  23 
  22 PB  RFSH  0                           Sets status word  24 
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  23 EAD SPR1  0.0000           #  P       Contr strat         25 
  24 S16 ENR1  ENUM                   16               28 
  25 ID  CHST      0                                   N     29 
  26 EAD SPR2  0.0000           #  P       Setpoint 1        30 
  27 EAD LOR2  0.0000           #  P       High limit        33 
  28 EAD UPR2  0.0000           #  P       Low limit        34 
  29 EAD SPR3  0.0000           #  P       Setpoint 2        35 
  30 EAD LOR3  0.0000           #  P       High limit        38 
  31 EAD UPR3  0.0000           #  P        Low limit        39 
  32 EAD SPR4  0.0000           #  P       Setpoint 3        40 
  33 EAD LOR4  0.0000           #  P       High limit         43 
  34 EAD UPR4  0.0000           #  P       Low limit        44 
  35 EAD SPR5  0.0000           #  P       Setpoint 4        45 
  36 EAD LOR5  0.0000           #  P       High limit         48 
  37 EAD UPR5  0.0000           #  P       Low limit        49 
  38 EAD SPR6  0.0000           #  P       Setpoint 5        50 
  39 EAD LOR6  0.0000           #  P       High limit        53 
  40 EAD UPR6  0.0000           #  P       Low limit        54 
  41 EAD SPR7  0.0000           #  P       Setpoint 6        55 
  42 EAD LOR7  0.0000           #  P       High limit         58 
  43 EAD UPR7  0.0000           #  P       Low limit        59 
  44 EAD SPR8  0.0000           #  P     C                   60 
  44 EAD LOR8  0.0000           #  P                         63 
  46 EAD UPR8  0.0000           #  P                         64 
  47 EAD SPR9  0.0000           #  P     C                   65 
  48 EAD LOR9  0.0000           #  P                         68 
  49 EAD UPR9  0.0000           #  P                         69 
  50 EAD SPRA  0.0000           #  P     C                   70 
  51 EAD LORA  0.0000           #  P                         73 
  52 EAD UPRA  0.0000           #  P                         74 
  53 EAD SPRB  0.0000           #  P     C                   75 
  54 EAD LORB  0.0000           #  P                         78 
  55 EAD UPRB  0.0000           #  P                         79 
  56 EAD SPRC  0.0000           #  P     C                   80 
  57 EAD LORC  0.0000           #  P                         83 
  58 EAD UPRC  0.0000           #  P                         84 
  59 EAD SPRD  0.0000           #  P     C                   85 
  60 EAD LORD  0.0000           #  P                         88 
  61 EAD UPRD  0.0000           #  P                         89 
  62 EB  SPRE  0                   P                         90 
  63 ID  ANSW      6                       Number Setpoints  93 
  64 PB  ITAK  0                         C                   94 
  65 EAD SIMU  0.0000              P       Simulation        96 
  66 EA  GF    0.0000              P       GF block   C  Q    97 
  67 EA  SKS   0.0000              P       SKS block  C  Q    98 
  68 EA  GAX   0.0000              P       GA block   C  Q    99 
  69 EB  GBX   0.0000              P       GB block   C  Q    100 
  70 EB  GMX   0.0000              P       GM block   C  Q    101 
  71 EA  GTX   0.0000              P       GT block   C  Q    103 
  73 S16 TUN1                         16 Unit Setp. 1    104 
  74 S16 TUN2                         16 Unit Setp. 2    105 
  75 S16 TUN3                         16 Unit Setp. 3    106 
  76 S16 TUN4                         16 Unit Setp. 4    107 
  77 S16 TUN5                         16 Unit Setp. 5    108 
  78 S16 TUN6                         16 Unit Setp. 6    109 
  79 S16 AT    *TECHNOLOG. NAME       16                     160 
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CTRL Assignment: 
 
Bit Meaning 
0 ISTART 
1 IHOLD 
2 IABORT 
3 IRESET 
4 ITERM 
5 reserved 
6 ISTOP 
7 reserved 
8 ICONT 
9 IPARAM 
CTRL contains all the control inputs that are written by SIMATIC BATCH. 
 
IREADY, ILOCK, and IREFRESH are used by the user program and are therefore 
not included in ICTRL. 
 
Assignment of Status Words USTAT_L and QUSTAT_L: 
 
Bit Meaning Comment Set when 
0 IDLE  static status inactive  
1 RUNNING static status running  
2 COMPLETED static status completed  
3 HELD  static status held  
4 ABORTED static status aborted  
5 READY  static status ready to complete IREADY = 1 
6 STOPPED static status stopped  
7 free   
8 free   
9 STARTING intermediate status starting  
10 RESUMING intermediate status resuming  
11 COMPLETING intermediate status completing  
12 HOLDING intermediate status holding  
13 ABORTING intermediate status aborting  
14 STOPPING intermediate status stopping  
15 free   
16 reserved (for SFC: manual/automatic requested)  
17 QCMOD  manual/automatic ID (1 = automatic)  
18 BA_EN  SIMATIC BATCH enable ID (1 = enabled) BA_EN = 1 
19 STEP_RT Runtime exceeded ID Q_STEP_T > STEP_T 
20 reserved (for SFC: operator request transition)  
21 REFRESH Trigger for reading setpoints/proc. Values IREFRESH = 1 
22 LOCK  Start lock ID (1 = locked) ILOCK = 1 
23 CONTINUOUS Continuous operation ID ICONT = 1 
24 OCCUPIED SIMATIIC BATCH allocation ID (1 = allocated) OCCUPIED = 1 
25 PROC_ERR (for SFC: process error)  
26 reserved (for SFC: execution error)  
27 reserved (for SFC: step execution time error)  
28 reserved (for SFC: configuration error)  
29 reserved (for SFC: operator error)  
30 reserved (for SFC: external error)  
31 ERROR  Group error  PROC_ERR = 1 
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9.4 TR1B Block Data Record 
 
 
   1 AAD EPEC  0.0000           #  P                        23 
   1 S16 FTYP  F_TYPE                 16   Type name         1 
   2 S16 UNIT  UNIT_NAME              16   Unit name         2 
   3 EB  QAB1  0                #  P       Binary value 1    3 
   4 EB  QAB2  0                #  P       Binary value 2    4 
   5 EB  QAB3  0                #  P       Binary value 3    5 
   6 EB  QAB4  0                #  P       Binary value 4    6 
   7 EB  QAB5  0                #  P       Binary value 5    7 
   8 EB  QAB6  0                #  P       Binary value 6    8 
   9 EB  QAB7  0                #  P       Binary value 7    9 
  10 EB  QAB8  0                #  P       Binary value 8   10 
  11 EB  QAB9  0                #  P       Binary value 9   11 
  12 EB  QABA  0                #  P       Binary value 10  12 
  13 EAD QAR1  0.0000           #  P       Analog value 1   13 
  14 EAD QAR2  0.0000           #  P       Analog value 2   14 
  15 EAD QAR3  0.0000           #  P       Analog value 3   15 
  16 EAD QAR4  0.0000           #  P       Analog value 4   16 
  17 EAD QAR5  0.0000           #  P       Analog value 5   17 
  18 EAD QAR6  0.0000           #  P       Analog value 6   18 
  19 EAD QAR7  0.0000           #  P       Analog value 7   19 
  20 EAD QAR8  0.0000           #  P       Analog value 8   20 
  21 EAD QAR9  0.0000           #  P       Analog value 9   21 
  22 EAD QARA  0.0000           #  P       Analog value 10  22 
  23 S16 AT    *TECHNOLOG. NAME       16                    30 
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9.5 UNIB Block Data Record 
 
 
   1 AAD QSTA  0.0000           #          Status word      20 
   2 AAD QUST  0.0000           #          User status       21 
   3 AAD VACT  0.0000           #          Lifebeat actual value 22 
   4 AB  OERR  0                #          Lifebeat monitoring   23 
   5 AB  MOR   0                #          Process value TMOR    25 
   6 AT  LZTI  0.0000           #          Timer             46 
   1 EB  BAEN  0                   P       Batch enable        1 
   2 EB  OCCU  0                   P       Allocated ID       2 
   3 EB  POOS  0                   P       Pending out of service 3 
   4 EAD BAID  0.0000              P       Batch ID          4 
   5 S16 BAN1  UBA_NAME               16   Batch name        5 
   6 S16 BAN2                         16                       6 
   7 S16 FOR1  FORMULA                16   Formula              7 
   8 S16 FOR2                         16                       8 
   9 S16 MAT1  MAT_NAME               16   Material name          9 
  10 S16 MAT2                         16                     10 
  11 S16 UNIT  UNIT_NAME              16   Unit name    11 
  12 S16 RPN1  URP_NAME               16   Recipe name        12 
  13 S16 RPN2                         16                     13 
  14 S16 RPR1  URP_REL                16   Recipe version    14 
  15 S16 RPR2                         16                     15 
  16 EAD USTA  0.0000              P       User status       16 
  17 EAD SPCT  0.0000           #  P       Lifebeat interval  17 
  18 S16 MASP  MAT_SP                 16   Material code         18 
  19 EB  LIFE  0                   P       Lifebeat      19 
  20 PB  TMOR  0                           Operator prompt  24 
  21 EA  STPM  0.0000              P       Sets status word  26 
  22 EA  RUST  0.0000              P       Sets status word  27 
  23 EA  CTRL  0.0000              P       Sets status word  28 
     24 S16 AT    *TECHNOLOG. NAME       16                     48 
 
 
9.6 Restoring the Initial Status 
 
You can restore the EM1B block to its initial state by setting the RST parameter to 1. The correspond-
ing GF block must be in automatic mode and correspond to the "OFF" state. 
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